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About This Book

The assignments in this book were written specifically for Microsoft Access 2010 and
Access 2007, but all of the tasks in the book can be completed using Access 2003.
However, as Access 2003 doesn’t use the Ribbon system, there will be instances where
references are made to commands that don’t exist in Access 2003. It is a ‘learning
through practice’ book with lots of practical assignments for the student. No previous
knowledge of databases is needed, as the assignments start at a very basic level. The
book contains four sections:

● Section 1: Beginners Database Assignments

● Section 2: Intermediate Database Assignments

● Section 3: Advanced Database Assignments

● Section 4: Introduction to Relational Databases

There are 10 practical database assignments, which are graded by level of difficulty.
Each assignment introduces new concepts and, with the exception of Assignment 1,
enables you to consolidate what you have learned in previous assignments.

Students who have no previous database experience should start at Section 1.
Students already familiar with Microsoft Access will be able to use this book as an
independent study guide and may wish to start at Section 2. However, these students
can practise and consolidate existing database skills by completing Section 1.

By completing all the assignments contained in Sections 1, 2 and 3 together with the
first part of the assignment in Section 4, you will have covered all the necessary course
material required to successfully complete the NFQ Level 5 Database Methods Module.
Students who are studying NFQ Level 6 Relational Databases or who simply wish to
learn about relational databases should also complete all of Section 4 of Step by Step
Databases.

Teachers have the option of downloading the records for each database assignment
from the Gill & Macmillan website. This cuts out the data entry phase and saves time in
the classroom. Full solutions for each of the 10 database assignments are also available
online, as well as project guidelines and sample exams.

New versions of Microsoft Access will be introduced over time. Because the
assignments in this workbook deal more with the principles of databases than the
features of Microsoft Access, I am confident that except for a few minor inconsistencies,
they will also work with future versions of Microsoft Access.

The following symbols are used throughout the book.

Tip Note Rule Cross-
reference

Shortcut Hint Important
Point

Theory
Section
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Each entry in the telephone
directory has three sections

Data in the telephone directory is in
ascending alphabetical order of name

Introduction

WHAT IS A DATABASE?

We all use databases in everyday life, sometimes without even being aware of it. The
most common example of a database is the telephone directory. These days, search
engines are running in a close second place. If you have used Google or Bing, then
you have used a database. If you use the Internet to buy products and services online,
then you have used a database. When you search for a song on iTunes or for a book
on Amazon, a database does the searching in the background. Whether you like it or
not, your details are stored in at least one database. The following is a list of databases
that you may find yourself in:

● Customer database for a bank.
● Loyalty card database for a supermarket.
● National database of PPS numbers.
● National database of registered vehicles.
● Database of any company from which you bought goods or services online.

The main function of a database is to store data. The data is stored in a particular order
and is divided into sections. For example, in the telephone directory, the stored data is
in alphabetical order of name and is divided into three sections – name, address and
phone number, as shown in Table 0.1.

Name Address Phone Number

Dunne, Adam 27 Killiney Towers 2682931

Dunne, Aileen 7 Park Drive 2076878

Dunne, Alan 32 Mount Anville Grove 2271883

Table 0.1

So, a database allows us to store data:

● With a specific structure.
● In a particular order.
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Step by Step Databases

A database can be recorded on paper or stored in a computer. The telephone directory
is an example of a database recorded on paper (it is also available online). One of the
disadvantages of paper-based databases is that it is time consuming to find specific
data and to view the data in different ways. Imagine trying to compile a list of all the
people who live in Dublin 4 from the telephone directory! You would first have to look
through every address and make a note of Dublin 4 addresses. Then you would have
to write out the name, address and telephone number of people with a Dublin 4 address
in a new list. In practice, it is not possible to do this in a paper-based database as big
as the telephone directory.

HISTORY OF DATABASES

Unlike a spreadsheet, you don’t need a computer to use a database. Consequently,
databases have been around a lot longer than spreadsheets. The first proper database
was developed in 1876 by Melvil Dewey to categorise books in a library. As computers
didn’t exist in 1876, Dewey’s database was paper based. It wasn’t until the 1960s, with
the advent of mainframe computers, that computerised databases became part of
everyday life. Mainframe computers were used by large organisations such as banks to
store and retrieve business data. Databases became available to the wider public when
IBM launched the first mass-market PC in 1981. The IBM PC came pre-loaded with
application software. The database application was dBase II. Figure 0.1 shows the menu
screen in dBase II.

Figure 0.1: dBase II on the IBM PC

The dBase program was very popular with PC users during the 1980s, and new
upgraded versions, dBase III and dBase IV, were introduced. When Microsoft launched
the first version of Access in 1992, it quickly became the database of choice for PC
users.

x
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xiIntroduction

ADVANTAGES OF COMPUTERISED DATABASES

Computerised databases offer great flexibility in the way you view data and also allow
you to find specific data in a matter of seconds. Data can also be sorted into different
orders (in ascending or descending alphabetical order or in ascending or descending
numerical order).

The main differences between a database recorded on paper and a computerised
database are summarised in Table 0.2.

Database Recorded Computerised
on Paper Database

Data in a structured format ✔ ✔

Data in a particular order ✔ ✔

Find specific data quickly ✘ ✔

View data in different orders ✘ ✔

Quickly perform calculations on 
groups of data ✘ ✔

Table 0.2

From Table 0.2, it can be seen that computerised databases offer greater flexibility than
databases stored on paper.

This book introduces the learner to computerised databases using Microsoft Access.
The learner will be guided through a series of graded assignments. Each assignment
introduces new concepts and tasks while building on concepts and tasks learned in
previous assignments. For the remainder of the book, the term ‘database’ will be used
when referring to a computerised database.

WHAT A DATABASE CAN DO FOR YOU

If, in the course of your work, you need to keep track of large amounts of data and that
data is constantly changing or being updated, then a database will save time and reduce
errors. For example, a school principal could use a database to store information about
students and subjects. This database could produce reports on students currently in the
college and the subjects they are studying. This information can be used by the school
principal when making decisions such as how many teachers should be employed, how
many classrooms are needed and how many exam scripts are required for each subject.

Mail Merge is an important feature of Access. It is used by direct mail and marketing
companies to create customised letters for customers stored in a database. The letters
are sent to customers to promote products and services offered by a company. Many
companies now communicate with their customers by linking their customer database
with an email application. This is much cheaper than using surface mail.
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Companies such as the National Car Testing Service (NCTS) would find it very difficult
to keep track of all the data they need to process without the help of a database. Using
a database, NCTS can determine which vehicles are due to be tested in the next month.
The database generates customised test notifications that inform each vehicle owner of
their forthcoming test.

With the growth of e-commerce, where products and services are sold via the
Internet, databases are becoming more and more important. All e-commerce sites, such
as iTunes and Amazon, rely on powerful databases to store details of their products and
orders made by customers. Without databases, these companies would not be able to
function efficiently.

In the course of business, people make decisions. The quality of the decision
depends on the information on which the decision is based. Business decisions based
on accurate database Reports, which are available at the click of a button, will be better
decisions.

An important point to note is that the database is only as good as the information it
stores. If you don’t update the database by entering new data as it occurs, the Reports
produced by the database will be inaccurate.

STRUCTURE OF A DATABASE

A database consists of objects. There are four main
object types that can be used in an Access database:
Tables, Queries, Forms and Reports. Access displays a
list of the objects in your database in the Navigation
Pane (Figure 0.2). Each object carries out a different
function within the database and should be given a
unique name. The database itself must also have a
name. At the very least, a database must have a Table
so that it can store data. The number of objects in a
database depends on the complexity of the database.
More complex databases will have more objects.

Figure 0.2: The Navigation Pane

CREATING A DATABASE

Before you can create objects such as Tables and Forms, you must create a database
to store the objects. The database is like a container. Initially it is empty, but as you work
through the assignments you will add Tables, Forms, Queries and Reports to each
database you create. It is important to note that you must name your database before
you start adding objects to it.

The way in which a database is named differs from other popular applications such
as word processing and spreadsheets. You can create a new word processing

Step by Step Databasesxii
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xiiiIntroduction

All the information relating to one club
member is called a record

document and start working on it before you save it. You may have two or three pages
of typed text before you click the Save button.

Access, on the other hand, will not allow you to work with your database unless you
give it a name. If you forget to name your database, Access names it for you! (Normally
Access will assign the name Database1.accdb to your database.)

Access uses the .accdb file extension, which is an abbreviation of Access
database. Earlier versions of Access used the .mdb file extension.

Database Example

I will use an example of a tennis club database to
explain each of the four objects in an Access
database. To keep things simple, the club has
only six members. Figure 0.3 shows the
Navigation Pane, which lists the objects in the
database. Data relating to the tennis club is
stored in the Club Members Table.

Figure 0.3: Tennis club database

TABLES

The Table is the most important object in the database. The function of the Table is to
store data. Data stored in the Table must be broken down into smaller pieces of data,
called fields. This is shown in Table 0.3.

Member No Firstname Surname Gender Phone Date of Birth

1 Paul Moore Male 2036558 20/06/1982

2 Deirdre O Connell Female 5440291 15/10/1988

3 Konrad Frejek Male 8795412 03/01/1987

4 Ross Mooney Male 4590298 28/02/1986

5 Cathy Duffy Female 8701593 21/08/1985

6 Geraldine Abbey Female 3390217 12/12/1989

Table 0.3

Data stored in the Table is divided into columns, which in database terminology
are called fields. The field names are in the top row of the Table.
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QUERIES

A Query allows us to find specific records in the Table. For example, a 
Query could find all records of female club members, as shown in Table 0.4
and Table 0.5.

Member No Firstname Surname Gender Phone Date of Birth

1 Paul Moore Male 2036558 20/06/1982

2 Deirdre O Connell Female 5440291 15/10/1988

3 Konrad Frejek Male 8795412 03/01/1987

4 Ross Mooney Male 4590298 28/02/1986

5 Cathy Duffy Female 8701593 21/08/1985

6 Geraldine Abbey Female 3390217 12/12/1989

Table 0.4: The Table stores records of all club members

Member No Firstname Surname Gender Phone Date of Birth

2 Deirdre O Connell Female 5440291 15/10/1988

5 Cathy Duffy Female 8701593 21/08/1985

6 Geraldine Abbey Female 3390217 12/12/1989

Table 0.5: The Query displays only female club members

In the example, the Query has searched through the Table, record by record. Each time
it finds a female club member, that record is extracted from the Table and displayed in
a separate list. The completed Query displays three female club members.

FORMS

The main function of a Form is to provide a convenient method of entering data into the
Table. A Form can also be used to edit or add to data already stored in the Table. The
Form is linked to the Table. When you enter data in the Form, it filters down into the
Table.
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Member No Firstname Surname Gender Phone Date of birth

1 Paul Moore Male 2036558 20/06/1982

Figure 0.4: Data is transferred from the Form to the Table

In Figure 0.4, Paul Moore’s record has been entered in the Form. Because the Form is
linked to the Table, Paul’s record filters down to and is stored in the Table. The arrows
indicate how data is transferred from the Form to the Table. The function of the Form is
to facilitate data entry. The function of the Table is to store data.

REPORTS

People in business base their decisions on data they receive while they are at work.
This data can come from lots of different sources, such as business transactions, news
reports and colleagues. Many business decisions are based on data retrieved from
databases. The reporting facility in Access provides a means of presenting data so that
it can be easily interpreted by the decision maker. In an Access Report, data can be
summarised, formatted and presented in a way that makes it easy to understand. In the
tennis club database, we could use a Report to create a member contact list, as shown
in Figure 0.5.

Figure 0.5: An Access Report

xvIntroduction

Data from a Table or
Query can be
formatted and

displayed in a Report

Form

Table

Report functions can
be used to perform
calculations on the

data displayed in the
Report
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STEPS IN CREATING A DATABASE

Regardless of how complex a particular database assignment is, the first four steps will
always be as follows:

1. Create and name the database.
2. Create a Table to store the data.
3. Create a Form to enter the data.
4. Enter data using the Form.

Once the data has been entered, it can be analysed and summarised using Queries
and Reports.

USING DATABASE OBJECTS

Each object in the database can be viewed in three ways.

1.  First, you can look at how an object is designed. Use this
option if you want to change the format or layout of a Table,
Form, Query or Report. Design view is generally used when

you first create an object. When you are in design view, you will only see the structure
of the object. You cannot view or enter data in design view.

2.  Layout view only applies to Forms and Reports. This view
allows you to change the design of an object while viewing
the data in the object. For example, you could adjust the

column widths in a Report while viewing the data displayed in the Report. Layout view
is useful for fine tuning the design of a Form or Report.

3.  Finally, once an object has been designed and fine tuned, you will want to use the
object. Each object has its own specific view (Table 0.6).

Table Query Form Report

Table 0.6

Opening a Table in datasheet view displays the records stored in the Table. Query
datasheet view displays the records found by the Query. Opening a Form in Form view
allows you to enter and edit data. Report view displays the data contained in a Report.

Figure 0.6: Tabbed objects in Access

Step by Step Databasesxvi
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The name of each object that is currently open is displayed in a separate tab. In Figure
0.6, the College Computers Form, PCs in room 12 Query, PC Labels Report and PCs
Table are open. You can quickly switch between objects by clicking the tabs.
Access uses different icons to represent Tables, Queries, Forms and Reports. These
icons, which are displayed in each of the tabs in Figure 0.6, are explained in Table 0.7.

Icons Used in Access

Table Query Form Report

Table 0.7: Icons used to represent Tables, Queries, Forms and Reports

ACCESS WIZARDS

Each time you create a new object in Access, you have the option of either:

1. Getting help from a wizard.
2. Doing all the work yourself by creating the object in design view.

Most of the wizards in Access are very good and can save you a lot of time by doing the
basic set-up of an object for you, giving you more time to work on the finer details.
However, some of the wizards are a little confusing, particularly for new database users.
As you work through the assignments in this book, you will learn how to create Tables,
Queries, Forms and Reports. Each time you are required to create an object, I will
recommend whether you should get help from a wizard or create the object in design
view.

THE NAVIGATION PANE

The Navigation Pane, which appears on the left
of the screen, allows you to access and manage
the objects in your database. The Navigation
Pane has a separate section for Tables, Queries,
Forms and Reports, as seen in Figure 0.7. Each
section can be expanded to display a list of
objects by clicking the double down arrow.

Figure 0.7: The Navigation Pane

xviiIntroduction

To see a full list of Reports, click
the double down arrow
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xviii Step by Step Databases

Figure 0.8 is an example of the Navigation Pane
displaying all Access objects. The Navigation Pane can
be hidden by clicking the << symbol displayed at the
top right-hand side of the Navigation Pane. This makes
the full screen available for your database.

Figure 0.8

THE RIBBON

In Access 2007, the menus and toolbars were replaced by the Ribbon, which helps you
quickly find the commands that you need to complete a task.

Figure 0.9: In Access 2007, commands in the Ribbon are 
organised into four basic groups

In Access 2010, Microsoft updated the Ribbon to include the File tab (Figure 0.10).

Figure 0.10: As Access users were confused by the Office button, the File tab 
was added to the Ribbon in Access 2010

Using the Ribbon is very intuitive. Commands in the Ribbon are organised into four
basic groups: Home, Create, External Data and Database Tools (Figure 0.9 and Figure
0.10). As objects in the database are opened, additional groups of commands are
displayed in the Ribbon. For example, when you open a Table, the Datasheet group is
added to the four existing groups in the Ribbon. Groups are also added to the Ribbon
as you change the way you view an object.
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xixIntroduction

Figure 0.11: The Ribbon when an Access Form is opened in design view

In Figure 0.11, three additional groups appear in the Ribbon when you open a Form in
design view. The additional Design, Arrange and Format groups contain commands to
help you design and format your Access Form.

A specific group of commands in the Ribbon can be selected by clicking the
appropriate tab. Each group in the Ribbon is divided into sections of related buttons.
Figure 0.10 displays the commands in the Home section of the Ribbon, which is
displayed by default. It contains the Views, Clipboard, Sort & Filter, Records, Find and
Text Formatting sections. Commands in the Home section of the Ribbon can be used
for formatting, copying and pasting, finding and editing records as well as sorting
records in your database.

If you like using shortcut key combinations, you can access Ribbon commands by
pressing ALT on the keyboard. Once you press ALT, letters representing each Ribbon
group are displayed together with the letter F, which represents the Office button
(Access 2007) or File tab (Access 2010). This is displayed in Figure 0.12 and Figure
0.13. The buttons in the Quick Access Toolbar are represented by numbers.

Figure 0.12: Keyboard shortcuts in Access 2007

Figure 0.13: Keyboard shortcuts in Access 2010

Shortcut key combinations for the commands in a specific Ribbon group can be
displayed by typing the appropriate letter on the keyboard. For example, pressing H
displays the shortcut key combinations for the Home group, as shown in Figure 0.14.
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xx Step by Step Databases

Figure 0.14: Shortcut key combinations in the Home group

In Figure 0.14, the keyboard shortcuts for the Home group of commands are displayed.
Each keyboard shortcut can be used to access a specific command or button. For
example, typing 1 will format the selected item to bold. The complete sequence of
commands is ALT+H+1. If you use these keyboard combinations frequently, they can
speed up many tasks.

Commands that are available in the Ribbon will depend on the view you are in and
the task you are completing. Keyboard shortcuts for commands that are currently
unavailable will appear dimmed. For example, in Figure 0.14, paste is currently
unavailable. The associated shortcut key, V, is dimmed.

THE OFFICE BUTTON AND FILE TAB

In Access 2007 the File menu was replaced by the Office button. Commands to create
or open database files do not appear in the Ribbon and are instead accessed by clicking
the Office button, as shown in Figure 0.15.

Figure 0.15: In Access 2007, common commands and recently used databases 
are accessed by clicking the Office button

Office
button

Quick Access toolbar
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xxiIntroduction

The Recent Documents panel can be used to quickly open the databases you have
recently been working on. 

The Office button caused confusion amongst computer users who were accustomed
to managing their documents via the File command. The confusion was so great that
in Access 2010, Microsoft replaced the Office button with the File tab. Clicking the File
tab displays the options shown in Figure 0.16.

Figure 0.16: In Access 2010, file management tasks are grouped under the File tab

QUICK ACCESS TOOLBAR

The Quick Access Toolbar (Figure 0.17) contains frequently used commands. It appears
to the right of the Office button and is used to quickly access buttons for common tasks,
such as opening an existing database or creating a new database. The Undo and Redo
buttons also appear in the Quick Access Toolbar.

Figure 0.17: The Quick Access Toolbar

Because the Quick Access Toolbar is always visible, adding buttons that you frequently
use to this toolbar makes the buttons readily available.

POP-UP MENUS

Pressing the right mouse button will display a pop-up menu in Access. Different pop-
up menus will appear depending on where the mouse pointer is on the screen. Right

Save Undo Redo
Open an existing database

Create a new database
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xxii Step by Step Databases

clicking on an object name in the Navigation Pane displays
the menu shown in Figure 0.18.

Using the options displayed in Figure 0.18, you can open
the object or view it in design or layout view. You could also
rename, delete, cut, copy, hide or export the object to
another database as well as viewing the properties of the
object.

Pop-up menus can also be used in design view. For
example, right clicking the Form title when in design view
displays a list of options that can be used to format the Form
title.

In datasheet view, Form view and Report view, pop-up
menus have options to sort and filter data.

GETTING HELP IN ACCESS

Access contains a powerful help feature that can be accessed either by clicking
the question mark in the top right-hand corner of the screen or by pressing F1

on the keyboard.
To search for help on a

particular aspect of Access,
type your search term into the
search box and then click the
Search button. Figure 0.19 is
an example of using the help
feature to find information on
the Ribbon.

In Figure 0.19, Access is
displaying the top 100 articles
related to the Ribbon. To read
an article, simply click the
article title.

Figure 0.18

Figure 0.19: An example of searching for help 
on the Ribbon
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ACCESS SECURITY WARNINGS

Each time you open an Access database, you will see a security warning (Figure 0.20).

Figure 0.20: Security warning upon opening an Access database

The following items in an Access database can pose security risks:

1. Action queries: A Query which finds and updates records.
2. Macros: A computer program generated by Access.
3. VBA code: A computer program written by a database programmer.

This book does not deal with VBA code. However, action queries and macros are
introduced in Section 4 of the book. When working through the assignments in Sections
1, 2 and 3 it is perfectly safe to ignore the security warnings as long as you are opening
a database assignment that you created yourself. The best way to do this is to click the
X that appears to the right of the warning (Figure 0.20).

LIMITS OF ACCESS

Access is a great database application designed to work on PCs, laptops and tablets
and on network servers. It works really well for standard record-keeping and reporting
in an office. In general, Access functions efficiently as long as the database is smaller
than 2 gigabytes. (You’d need a huge amount of records for the database to get this
big!) However, for database applications that need to store digital content (e.g. photos,
videos, music) or keep track of huge volumes of orders on a commercial website,
Access may not be the best choice. More powerful databases, such as Oracle, are
generally used for these types of business applications.

ACCESS VS. EXCEL

Many students find it difficult to understand the difference between a database and a
spreadsheet. Databases are great for storing large amounts of data and then retrieving
that data very quickly. Spreadsheets are all about numbers and calculations. To use an
analogy, a database is a bit like a computerised telephone directory and a spreadsheet
is like a computerised pocket calculator.

SbyS databases 2013_Layout 1  23/01/2014  09:00  Page xxiii



HOW IT ALL WORKS TOGETHER

Club members

Data is recorded on
source documents
such as application
forms

Data is entered in the
database using a Form

Because the Form is
linked to a Table, data
entered in the Form filters
down to and is stored in
the Table

A Query finds records
in response to a
question A Report summarises,

organises and formats
data

How many club
members are

female?

Database

Data Out
(Query)

Query 
Gender

Female
Female
Female

Report

Member contact 
list

Number of 
members 6

A Report linked to the
Table displays all the

records
Report

Women’s 
competition

Number of 
entrants 3

A Report linked to a
Query displays only 
the records found by

that Query

Data Out
(Report)

xxiv Step by Step Databases
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1 College of E-Commerce Database

SCENARIO

The College of E-Commerce runs night classes in a number of different subjects
ranging from Administration to Web Design. In Assignment 1 you will create a
database to store and update data relating to students currently attending the
college.

By completing this assignment, you will learn how to:
● Create a database.
● Create a Table to store data.
● Create a Form to enter data.
● Enter data using a Form.
● Make basic changes to Form design.
● Use a Form to find, edit and delete records.

TABLES

The Table is the most important object in a database. Its task is to store data. A database
cannot function without a Table. The Table is divided into columns and rows. The
columns are called fields and the rows are called records. All records in the Table must
have the same number of fields. A record is a collection of data about a single item. In
Table 1.1, each record stores data about an individual student. Table 1.1 displays the
data that you will enter in the College of E-Commerce database later on in this
assignment. 
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Step by Step Databases2

All the information
relating to one student

is called a record

Student Student Age Course Date Started Teacher
Code Name

BS001 Peter Dunne 18 Admin 02/09/2014 Tadhg Allen

BS002 Mark Connolly 17 Admin 02/09/2014 Tadhg Allen

BS003 Dave O Neill 21 Finance 02/09/2014 Gerry Browne

BS004 Maura Keegan 18 Finance 02/09/2014 Gerry Browne

BS005 Ann Murphy 20 Admin 02/09/2014 Tadhg Allen

CP001 Enda Doyle 19 Web Design 09/09/2014 Noelle Duffy

CP002 Seamus Lowry 18 Database 09/09/2014 Liam Kearney

CP003 Tetyna Maryshko 18 Database 09/09/2014 Liam Kearney

CP004 Christine O Donnell 20 Web Design 09/09/2014 Noelle Duffy

CP005 Martin Murray 19 Database 09/09/2014 Liam Kearney

Table 1.1

CREATING A TABLE

The top row of the Table contains the field names: Student Code, Student Name, Age,
Course, Date Started and Teacher. Rows of records appear below the field names. All
the data relating to a specific student is called a record.

The fields define the structure of the Table. Before we can enter data in the database,
each field must be set up in the Table. When setting up a field, you must name the field
and specify what type of data you intend to store in that field. Field names and data
types for the Student Details Table are displayed in Table 1.2.

The data is divided into
six columns, each of
which is called a field

Tables are the most important
part of any database. The Table
stores data. Before data can be

stored in a Table, it must be
organised so that each record

has the same structure. In Table
1.1 the data has been divided

into six columns, which are
called fields.
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Field Name Data Type

Student Code Text

Student Name Text

Age Number

Course Text

Date Started Date/Time

Teacher Text

Table 1.2

Selecting a Data Type

Table 1.2 contains three different data types: Text, Number and Date/Time.

1. Text Data Type
The Text data type is used to store letters and combinations of letters and numbers.
Common examples would be a person’s name and car registration number. Phone
numbers including area codes, e.g. (021) 6689017, are also stored in Text fields. This
is because brackets cannot be entered in Number fields. Numbers with leading zeros,
e.g. 00200102, will also need to be stored in Text fields, as Access removes the leading
zeros when they are entered in a Number field.

2. Number Data Type
The Number data type is used to store numbers. In later assignments, you will learn
about the Byte, Integer, Long Integer and Single Number types. It is important to note that
Access will not allow you to enter letters or symbols in a field with a Number data type.

3. Date/Time Data Type
The Date/Time data type is used to store dates and times. When entering dates, the
days, months and years are separated using the forward slash (/). When entering times,
hours, minutes and seconds are separated using the colon (:). 

You will learn more about data types in later assignments.

PRIMARY KEY

Each time you create a new Table, Access automatically sets up a primary key field. A
primary key field differs from other fields in the Table in a number of important ways.

1. Once a field has been identified as the primary key field, Access will not allow you to
duplicate data in that field. For example, if the Order Number field is the primary key
field, each unique order number can only be entered once. If you attempt to enter an
order number that is already stored in the Table, Access will display an error message.

College of E-Commerce Database 3
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4 Step by Step Databases

2. While the fields define the structure of each record in the Table, the primary key
determines the order of records in the Table. Records in the Table are automatically
stored in ascending order of the primary key field, even if they are not entered in this
order.

Access will not allow you to complete data entry of a record unless you have entered
data in the primary key field. The primary key allows Access to uniquely identify each
record. This is particularly important in large databases. For example, in a customer
database, the primary key allows Access to distinguish between two customers who
have the same first name and surname. Sometimes the primary key will occur naturally
in the data. For example, in a database that stores details of cars for sale, the obvious
candidate for the primary key field is the car registration number. This is because each
car has its own unique registration number. In many databases, the database designer
has to make up the primary key to ensure that each record can be uniquely identified.
For example, your bank account number is a primary key generated by the bank’s
database. It ensures that each customer’s bank account has a unique identification
code. This is particularly important in cases where some customers have the same
name. Other common examples of primary keys are PPS numbers, club membership
numbers, credit card numbers, medical card numbers and order numbers.

FORMS

The Form is an important object in the database. Its main function is data entry. As data
is entered in the Form, Access transfers it to the Table record by record. An example of
this is shown in Figure 1.1. 

Figure 1.1: 
Each record entered in the Form is automatically transferred to the Table

In Figure 1.1, Peter Dunne’s record has been entered in the Form. As the Form is linked
to the Student Details Table, Access automatically transfers this data from the Form and
stores it in the Student Details Table.

Data is transferred from the Form to the Table record by record and not field by
field. This means that the record that you are currently entering in the Form is not
actually transferred to the Table until you move on to the next record, either by
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College of E-Commerce Database 5

pressing the Tab or Enter key on the keyboard or by clicking the Next Record
button in the Form.

An Access Form may be thought of as a digital version of a paper form such as a job
application form. Forms make the task of data entry easier, quicker and more accurate
for a number of reasons:

● Rather than typing data, it can often be selected from a list, e.g. selecting the flight
destination from a drop-down list when booking a flight on the Internet.

● Forms can be made attractive and easier to use through the use of formatting. 
● Titles, images and explanatory text can be added to a Form.

As well as entering data, Forms can also be used to edit records that are stored in the
Table. Later on in this assignment you will use a Form to edit and delete records.

Students new to databases often enter data directly in the Table. It is more efficient
to use the Form for data entry, as it was specifically set up for this purpose.

STRUCTURE OF A FORM

Forms created using the Form Wizard have two sections: the Form header and detail section.

1. The Form Header

Figure 1.2

The Form header (Figure 1.2) normally contains the Form title. Other items, such as
company logos and graphics, can also be added to the Form header.

2. The Detail Section

Figure 1.3

The detail section (Figure 1.3) is the main section of the Form. It normally contains all
the fields that are included in the Form. The detail section is used for data entry and is
the most important section of the Form.
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6 Step by Step Databases

A third section, called the Form footer, can also be added to the Form. The Form
footer appears at the bottom of the Form and can be used to display summary
information. It could also be used to display the date or time.

VIEWING AN ACCESS FORM

There are three ways to view an Access Form: Form view, design view and layout view.
1. Form View
Use this view to enter new records and edit
existing records.

Figure 1.4 displays the Student Registration Form in
Form view. Data relating to Peter Dunne has been
entered using the Form.

2. Design View
Use this view to change the design,
layout and formatting of your Form.

Figure 1.5 displays the Student Registration Form
in design view. Field names appear instead of
data when you are in design view. For example,
Student Code is displayed instead of BS001 and
Student Name is displayed instead of Peter
Dunne.

3. Layout View
Use this view to change the design of your Form while viewing the data.

Figure 1.6

Figure 1.4

Figure 1.5
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College of E-Commerce Database 7

Figure 1.6 displays the Student Registration Form in layout view. Layout view is a
combination of Form view and design view. In layout view, you can make changes to the
design of the Form while viewing the data. However, in layout view you cannot see the
detailed structure of the Form, which is displayed in design view. Although you can see
existing data in layout view, you cannot enter new data.

STRUCTURE OF AN ACCESS FORM

An Access Form has two main sections: the Form header and the detail section (Figure
1.7). 

Figure 1.7: 
Design view of the Student Registration Form, created later on in this assignment

Figure 1.7 displays the Student Registration Form in design view. You will create this
Form later on in this assignment. The Form title is displayed in the Form header. The
detail section displays a series of labels and text boxes. Each label/text box combination
represents a specific field in the Table. 

Before starting this assignment, ensure that Access is set up to display Tables,
Forms, Queries and Reports as tabbed documents.

● Click the File tab in the top left-hand corner of the screen.
● Select Options.
● Select Current Database from the list of options.
● In Document Window Options, select Tabbed Documents.

If you are using Access 2007, click the Office button, select Access Options and
then select Current Database from the Access Options list. In Document Window
Options, select Tabbed Documents and tick the Display Document Tabs check
box.

Label

Form
title

Text
box
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8 Step by Step Databases

DATABASE SET-UP

Setting up the College of E-Commerce database is completed in five distinct stages.
1. Create a new database.
2. Create the Table.
3. Create the Form.
4. Fine tune the Form layout.
5. Enter data.

Create a New Database

1. To start Microsoft Access, click the Start button and select Programs or All Programs.
In the Microsoft Office group, select Microsoft Office Access.

2. Click the Blank Database button, which appears in the top left-hand
corner of the screen.

3. Enter College of E-Commerce as the file name (Figure 1.8). 

Figure 1.8: Creating a new database

4. Click the folder icon (Figure 1.8) and select the folder where the new database will
be saved. (It will be a different folder to the one displayed in Figure 1.8.)

5. Click OK and then click the Create button. A new database opens, with a Table
already set up.

Remember to name your database when you create it. If you forget to enter a
name for your database, Access will name it Database1.accdb. If you want to
open this database at a later stage, you may not remember the name that Access
gave it.

All Access databases are automatically saved with the file extension .accdb,
which is an abbreviation of Access Database.
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College of E-Commerce Database 9

Create the Table

Each time you create a new database in Access, a new blank Table is displayed in
datasheet view (Figure 1.9). Note that Access has already set up an ID field. This is the
primary key field. 

1. Click the Save button, either in the Quick Access Toolbar or in the Office Menu. 
Alternatively, right click the tab for Table1 and select Save from the pop-up menu. The
Save As dialog box is displayed (Figure 1.9).

Figure 1.9: Student Details has been entered as the Table name

2. Enter Student Details as the Table name in the Save As dialog box, as shown in
Figure 1.9.

3. Click OK to name and save the Table.

4. In the Home section of the Ribbon, click the Design View button.

Figure 1.10: Design view of the Student Details Table

5. Change the field name of the ID field to Student Code, as shown in Figure 1.10.
Select Text from the list of data types for the Student Code field.
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10 Step by Step Databases

6. Set up the remaining fields and select the data types, as shown in Figure 1.11.

Figure 1.11: Field names and data types in the Student Details Table

7. Right click the tab for the Student Details Table and select
Save from the menu.

8. Close the Student Details Table.

Create the Form

1. In the Create section of the Ribbon, select
Form Wizard from the More Forms drop-down
list (Figure 1.12).

In Access 2007, the Form Wizard is in the More Forms drop-down list.

2. Add all fields in the Student Details Table to the Form by clicking the double
arrow. Fields that have been added to the Form will appear in the Selected
Fields box (Figure 1.12).

Figure 1.12: All fields in the Student Details Table have been added to the Form

All the fields in
the Student

Details Table
have been

added to the
Form

The Form is
linked to the

Student
Details Table
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College of E-Commerce Database 11

3. Click the Next button.
4. Accept Columnar as the Form layout by clicking the Next button once again.
5. Enter Student Registration as the Form title. Click Finish.

Access users should refer to the note at the end of this section.

Fine Tune the Form Layout

Figure 1.13: The completed Student Registration Form

1. Figure 1.13 displays the completed Student Registration Form.
Some of the text boxes are too wide and must be adjusted.
Changes to the design of an Access Form can be made in layout
view or design view. While layout view is very useful for fine
tuning Form design, the initial set-up and design of a Form is best
done in design view.

In the Home section of the Ribbon, select design view from
the View drop-down list.

2. Select and resize each text box individually. Point at the dot at the right-hand
side of the selected text box. Drag to the left when the mouse pointer changes
to a double horizontal arrow. Figure 1.14 demonstrates the resizing of the
Student Code text box using this method. Resize all other text boxes so that
they appear like Figure 1.14.

Figure 1.14: Use the double arrow mouse pointer to resize a text box

Form title

Text boxes

Labels
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Step by Step Databases12

Adjusting the width of a text box in a Form has no effect on the field size of the
corresponding field in the Table.

3. Right click the Student Registration tab and select Save from the pop-
up menu.

4. Adjustments to the design of the Student Registration Form are
now complete. In the Home section of the Ribbon, click the
Form View button to switch from design view to Form view. To
enter data using an Access Form, you must be in Form view.

Important note for Access 2007 users: In Access 2007, all of the labels and text
boxes in the Detail section of the Form were grouped in a single layout. The effect
of this is that resizing a particular text box also resizes all of the other text boxes
in the Detail section. You will only be able resize text boxes individually once you
remove the labels and text boxes in the Detail section from the existing layout.
Follow these steps.

1. Select all labels and text boxes by clicking the cross symbol in the top left-hand
corner of the Detail section (to the left of the Student Code label).

2. In the Design section of the Ribbon, click the Remove button to ungroup the text
boxes. This allows each text box to be resized independently.

3. De-select all labels and text boxes by clicking in a blank area of the Detail section.
4. Continue from step 2 in the ‘Fine Tune the Form Layout’ section.

Enter Data

With the Student Registration Form in Form view, enter all the records shown
in Table 1.3. To move to the next field, press the Tab key on the keyboard.

If necessary, adjust the width of text boxes (using layout view) as
you enter the data.

Student Student Age Course Date Started Teacher
Code Name

BS001 Peter Dunne 18 Admin 02/09/2014 Tadhg Allen

BS002 Mark Connolly 17 Admin 02/09/2014 Tadhg Allen

BS003 Dave O Neill 21 Finance 02/09/2014 Gerry Browne

BS004 Maura Keegan 18 Finance 02/09/2014 Gerry Browne

BS005 Ann Murphy 20 Admin 02/09/2014 Tadhg Allen

CP001 Enda Doyle 19 Web Design 09/09/2014 Noelle Duffy

CP002 Seamus Lowry 18 Database 09/09/2014 Liam Kearney

CP003 Tetyna Maryshko 18 Database 09/09/2014 Liam Kearney

CP004 Christine O Donnell 20 Web Design 09/09/2014 Noelle Duffy

CP005 Martin Murray 19 Database 09/09/2014 Liam Kearney

Table 1.3
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You can make adjustments to your Form as you are entering the data using layout
view.

Figure 1.15: Adjusting the Student Name text box in layout view

Layout view allows you to view the data you have entered while making
adjustments to the design of the Form. In Figure 1.15, the Student Name text
box is being adjusted to prevent the text from wrapping. You can’t enter data

in layout view, so you will need to click the Form View button when you have finished
adjusting your Form.

Data is saved automatically as it is entered in a Form. There is no need to click
the Save button to save the records you have entered. You only need to click the
Save button when you make adjustments to the design of a Form.

Use the Form to Edit Data

1. Edit Existing Records

Maura Keegan has switched from the Finance course to the Web Design course. This
information needs to be updated in the database.

1. With the Student Registration Form open in Form view, click in the text box
containing the Student Name.

2. In the Home section of the Ribbon, click the Find button.
3. Type Maura Keegan in the Find What box.
4. Click Find Next. Maura Keegan’s record is now displayed on the screen.
5. Change Maura’s course from Finance to Web Design.

You can quickly display the Find and Replace dialog box using the CTRL + F
keyboard combination.

Edit the following records using the Student Registration Form:
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Click in the Student Name text box before clicking the Find button.

● Ann Murphy started on 16/9/2014.
● Martin Murray’s age is 20.
● Tetyna Maryshko is in the Finance course.
● Enda Doyle started on 02/09/2014.

2. Delete a Record

1. Find the record for Mark Connolly using the Find button. Close the Find
and Replace dialog box.

2. In the Home section of the Ribbon, select Delete Record
from the Delete drop-down list.

3. Click Yes to confirm that you want to delete this record.

3. Add a New Record

Click the New Record button on the toolbar and enter the following
information:

A new student, Keith Little, aged 19, has joined the Admin course. His start date is
24/09/2014. His teacher will be Tadhg Allen and his Student Code is BS006.

ASSIGNMENT SUMMARY

Basic Concepts

Table A database object that stores data. It is divided into rows and
columns. The rows are called records. The columns are called
fields. 

Field A specific column in the Table, e.g. Student Name. The data type
of a field reflects the data that it stores, e.g. text, number,
date/time.

Record A specific row in the Table.

Primary Key A special field in a Table where data cannot be duplicated.
Records in the Table are stored in ascending order of the primary
key field.

Form A database object designed to facilitate data entry. The Form is
linked to the Table. Data entered in the Form filters down to and
is stored in the Table.

Label/Text Box Each label/text box combination in the Form is linked to a specific
field in the Table. Data is entered in the text boxes. Descriptive text
is displayed in the labels.
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College of E-Commerce Database 15

Potential Pitfalls

● An Access Form is specifically designed for data entry. Although data can be entered
directly in the Table, it is best to use the Form for data entry.

● Once a particular field has been identified as the primary key, Access will not allow
you to duplicate values in that field.

● Access will not allow you to enter letters or symbols in a field with a Number data
type.

Useful Shortcut

Keyboard Combination Action

CTRL + F Find records in a Form

Table 1.4

Log on to www.gillmacmillan.ie to download review 
questions for Assignment 1.
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